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PC Maintenance 
This section includes information about tasks you can 
perform to help ensure the trouble-free operation of 
your PC, and to ease the recovery of important 
information on your PC should problems arise in the 
future. 

Creating Data Backup Discs 
You can use the CD or DVD burning software included 
on your PC to create backup discs of important 
information including personal files, e-mail messages, 
and Web site bookmarks. 

When writing data to a backup disc, you should use 
software that includes write verification functionality. 
This verification feature compares the data on your 
hard disk drive with the data copied to the disc to 
ensure it is an exact copy. Depending on your disc 
burning software, you may need to manually enable 
this feature. 

Removing Unused Programs 
1 Click Start, and then click Control Panel. 
2 Double-click Add or Remove Programs. The 

Add or Remove Programs window opens. 
3 Select the program you want to remove, and click 

the Change/Remove button. 
4 Follow the onscreen instructions. 

NOTE: Some programs have their own uninstall 
features. If you cannot uninstall a program from the 
Control Panel, try using the program to uninstall. 

Running the Disk Cleanup 
Program 
The Disk Cleanup program frees up space on your 
hard disk drive by removing temporary and unused 
files (including Temporary Internet Files and files in the 
Recycle Bin). You can run Disk Cleanup manually, or 
you can set it up to run automatically. 

Running Disk Cleanup manually 
1 Click Start, All Programs, Accessories, 

System Tools, and then click Disk Cleanup. 
Disk Cleanup searches for files to delete and 
calculates how much disk space can be saved. 

2 Choose the files to delete by placing a check mark 
in the check box next to the file types listed. 

3 Click OK, and then click Yes to finish deleting the 
selected files. 

Scheduling Disk Cleanup to run 
automatically 
1 Click Start, and then Run, and type the following 

into the open field (note there is a space between 
the r and the /): cleanmgr /sageset:100 

2 Select the types of files that you want removed (for 
example, temporary files, Temporary Internet Files, 
and the files in the Recycle Bin). 

3 Click OK to save the settings. 
4 Click Start, All Programs, Accessories, 

System Tools, and then click Scheduled Tasks. 
5 Double-click Add Scheduled Task and then 

click Next. 
6 Select Disk Cleanup from the application list and 

then click Next. 
7 Accept the default task name or type a name for 

the task, select when the task is performed, and 
click Next. 

8 Select the time and reoccurrence (if available), and 
click Next. Disk Cleanup may take a long time, so 
select a time when the PC is on but not in use. 

9 Enter your login name and password and 
click Next. 
If you do not have a password, leave the Password 
field blank and click Next. 

10 Select Open advanced properties for this 
task when I click Finish and click Finish. 

11 In the Run field of the Disk Cleanup window 
add /sagerun:100 at the end of the path. 
For example: 
C:\WINDOWS\system32\cleanmgr.exe 
/sagerun:100 

12 Click OK and, if prompted, verify your password. 
Disk Cleanup runs at the time you have set. 
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Running the Disk 
Defragmenter Program 
When Windows® stores files on your hard disk drive, 
it often divides them into multiple pieces (or fragments) 
so they fit into available space on the drive. When 
you attempt to open a fragmented file, it must be 
retrieved from more than one place, so the process 
takes more time. 

The Disk Defragmenter program groups the 
fragmented files together on your hard disk drive to 
improve PC performance. This does not affect the 
location of files and folders on your PC. 

NOTE: The Disk Defragmenter program may take a 
long time to complete. You can run it unattended 
overnight. 

1 Open the Windows Task Manager by pressing the 
Ctrl key, the Alt key, and the Delete key at the 
same time. 

2 On the Applications tab, select all the programs 
that are listed, and then click End Task. Close the 
Task Manager. 

3 Click Start, choose All Programs, 
Accessories, System Tools, and then click 
Disk Defragmenter. 

4 In the Volume column, select the hard disk drive you 
want to defragment (typically C:), and then click 
Defragment. 

 

If Disk Defragmenter repeatedly starts, a hidden 
background program is still accessing the hard disk 
drive. Restart the PC in Safe Mode and run the Disk 
Defragmenter program again: 

1 Click Start, Turn Off Computer, and then 
Restart. 

2 Press the F8 key as soon as the first logo screen 
appears. 

3 On the Windows Advanced Options menu, use the 
arrow keys to select Safe Mode and press the 
Enter key. 

4 Press the Enter key again to select the operating 
system. 

5 Log on to Windows. When the Desktop message 
appears, click Yes to continue in Safe Mode. 

6 After Windows starts, use the previous procedure to 
run the Disk Defragmenter program. 

Checking for Hard Disk Drive 
Errors 
Perform the following procedure to check the integrity 
of the hard disk drive in Windows XP. Close all open 
programs before beginning the disk check. 

1 Click Start, and then click My Computer. 
2 In the window that opens, right-click the hard disk 

drive that you want to check, and click 
Properties. 

3 In the Properties window, click the Tools tab. 
4 Under Error-checking, click Check Now. 
5 If desired, click the check box next to 

Automatically fix file system errors and 
Scan for and attempt recovery of bad 
sectors. 

6 Click Start. If prompted to restart, click Yes to 
restart the PC. 

Understanding Hard Disk Drive 
Space 
HP PCs with the Windows XP operating system 
preinstalled may appear to have a hard disk drive 
smaller than what is stated in the product 
specifications, in the documentation, or on the box. 
Hard disk drives are described and advertised by 
manufacturers in terms of decimal (base 10) capacity. 
Windows and other programs, such as FDISK, use the 
binary (base 2) numbering system. 

In decimal notation, one megabyte (MB) is equal to 
1,000,000 bytes, and one gigabyte (GB) is equal to 
1,000,000,000 bytes. In the binary numbering 
system, one megabyte is equal to 1,048,576 bytes, 
and one gigabyte is equal to 1,073,741,824 bytes. 
Because of the different measuring systems, you may 
see a difference between the size reported by 
Windows and the size advertised. The storage 
capacity of the hard disk drive is as advertised. 
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Windows reports smaller capacity in the Windows Explorer tool and in the My Computer window because it 
shows information about one partition on the hard disk drive at a time. The first partition contains the System 
Recovery information. 

Recommended Maintenance Schedule 

Daily Weekly Monthly 
Quarterly 
(seasonally) 

Manage e-mail 
• Delete e-mail from 

unknown sources. 
• Do not open 

untrusted 
attachments. 

• File e-mail. 

Protect against viruses, adware, and 
spyware 
• Update definition files or schedule a weekly 

automatic update. 
• Run a full virus, adware, and spyware scan 

or schedule a weekly automatic scan. 

Use Windows Update 
• Check for updates 

or schedule a monthly 
automatic update. 
(See the Getting Started 
guide for details.) 

Set new 
passwords 
(See the Getting 
Started guide for 
details.) 

Optimize performance 
• Run Disk Cleanup. (See “Running the Disk 

Cleanup Program” on page 1.) 
• Check for disk errors. (See “Checking for 

Hard Disk Drive Errors” on page 2.) 
• Run Disk Defragmenter. (See “Running the 

Disk Defragmenter Program” on page 2.) 

Review the Start menu 
• Set to launch only needed 

applications. 

Optimize your browser 
• Delete cookies. 
• Delete cache. 
• Delete history files. 

Clean up the desktop 
• Delete or uninstall 

unneeded icons 
and applications. 
(See “Removing Unused 
Programs” on page 1.) 

Empty the Recycle Bin 
• This, and other cleanup tasks, can be 

performed with the Disk Cleanup program. 
(See “Running the Disk Cleanup Program” 
on page 1.) 

Maintain overall 
condition 
• Check cleanliness. 
• Make sure ventilation is 

unobstructed. 
• Secure all connections 

and cabling. 

 

Back up important files to CD or DVD 
(See “Creating Data Backup Discs” on 
page 1.) 

Create a restore point 
in the Microsoft System 
Restore program 
For information, double-click 
the Help and Support 
icon on the desktop to open 
the Help and Support 
Center, type system restore 
into the Search box, and 
then click Search. 

Clean the PC, 
monitor, 
keyboard, and 
mouse 
• For detailed 

cleaning 
instructions, go to 
http://www. 
  hp.com/ 
  support, select 
your country/ 
region and 
language, search 
on your PC model 
number, and then 
search on the 
keyword cleaning.

http://www.hp.com/support
http://www.hp.com/support
http://www.hp.com/support
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Troubleshooting PC 
Problems 
This section contains a series of tables that describe 
possible solutions to problems that may occur when 
using your PC. Each table contains: 

• Symptoms that describe the sign or warning 
message for the type of problem. 

• Possible solutions that describe what you should 
do to try to solve the problem. 

 

The troubleshooting tables appear in the following 
order: 

• Audio (Speakers are sold separately.) 
• Video (TV tuners are select models only.) 
• CD and DVD Drives 

• Display (Monitor) (select models only) 
• Hard Disk Drive 
• Hardware Installation 
• Internet Access 
• Keyboard and Mouse (Features and buttons vary; 

wireless keyboard and wireless mouse are select 
models only.) 

• Power 
• Performance 
• Miscellaneous 

 

For additional information about monitor problems, or 
for problems relating specifically to your printer, refer 
to the documentation provided by the product 
manufacturer. 

 

Audio 

Symptom Possible solution 

Press the Mute button on the keyboard to see if the Mute feature is turned on. 
Or 
1 Click Start, and then click Control Panel. 
2 Click Sounds, Speech, and Audio Devices, and then Sounds and Audio Devices. 
3 Click the Mute check box to remove the check mark from the box. 

Click the task bar Volume icon ( ), or use the keyboard controls to increase the volume. 

Ensure powered (active) speakers are turned on. Active speakers have a power cord or batteries. 
Speakers are sold separately. 

Turn off your PC, and then unplug and reconnect the speakers to the Audio Out (green) connector on 
the PC. Turn on your PC. 

Press the Standby button (select models only), or press the Esc key on the keyboard to resume from 
Standby mode. 

No sound is 
produced. 

Unplug headphones if they are connected to your PC. 

Codec error 
messages appear 
when certain audio 
files are played. 

Open the file in Windows Media Player. Ensure Windows Media Player is configured to 
automatically download codecs. 
• If the correct codec is available, the file will play. Note that you must be connected to the Internet 

to download the codec file. 
• If the correct codec is not available, check to see if there is an update available for Windows 

Media Player. 
• For more information, open Windows Media Player Help, and then search the online Help 

for codec. 
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Video 

Symptom Possible solution 

Some video files do not play. Your file may be corrupted or in an unsupported format. Open the video file in a 
video editor, and then resave the file in a supported format. 

Codec error messages appear 
when I play certain video files. 

Open the file in Windows Media Player. Ensure Windows Media Player is 
configured to automatically download codecs. 
• If the correct codec is available, the file will play. Note that you must be 

connected to the Internet to download the codec file. 
• If the correct codec is not available, check to see if there is an update available 

for Windows Media Player. 
For more information, open Windows Media Player Help, and then search the online 
Help for codec. 

Files Needed To Display Video Are 
Missing or Corrupt error message 
appears. 

1 Click Start, right-click My Computer, and then select Properties. 
2 Click the Hardware tab, and then click Device Manager. 
3 Click the plus sign (+) next to Sound, video and game controllers. 
4 Double-click TV tuner (select models only). 
5 Click the Driver tab, and then click Update Driver. 
6 Select Install from a list or a specific location, and then click Next. 
7 Remove the check mark from Search removable media. 
8 Click Include this location in this search, and then click the Browse button.
9 Click the plus sign (+) in order, next to each of the following directories: 
• My Computer 
• C:\ 
• Drivers 

10 Click OK, Next, and then click Finish after the drivers are updated. 
11 Restart the PC. 

 

CD and DVD Drives 
Symptom Possible solution 

Ensure the disc is inserted with the label facing up and centered in the tray. 

Wait at least 30 seconds to let the DVD drive determine the type of media. 

Clean the disc with a CD cleaning kit, available from most PC stores. 

The CD or DVD drive cannot read a 
disc or takes too long to start. 

The driver may be corrupted or outdated. For information, double-click the Help and 
Support icon on the desktop to open the Help and Support Center, type update 
driver into the Search box, and then click Search. 

I cannot remove a CD or DVD. Turn on your PC, and press the Eject button nearest the drive to open the tray. 
If you suspect a problem with the actual Eject button: 
1 Click Start and then My Computer. 
2 Right-click the CD or DVD drive you want to open. 
3 Select Eject from the menu. 
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CD and DVD Drives (continued) 

Symptom Possible solution 

Ensure the disc is inserted with the label facing up and centered in the tray. 

Verify that you are using the correct disc type (media) for the drive. Try a different brand 
of disc. 

Make sure the disc is clean and undamaged. If recording stopped during a recording 
session, the disc may be damaged; use a different disc. 

Use the correct type of disc for the type of files you are recording. 

When using a CD-R disc, make sure that it is blank when recording music and is blank or 
appendable (with space to add more data files) when recording data. 

Verify that you are using the correct disc type when making a copy of a disc. Some 
recording programs can record only to the same disc type as the source. For example, 
you can record a DVD only to a DVD+R/-R or a DVD+RW/-RW disc, and you can record 
a CD only to a CD-R or a CD-RW disc. 

Make sure the disc is in the correct drive and you specify the same drive in the CD or 
DVD recording software. 

Select a slower write speed for the recording drive, if it is available. 

The recording software may not let you add a track if it exceeds the available space on 
your disc. You can make space available by removing one or more tracks from the list 
before recording the files to disc. 

Close all software programs and windows before recording. 

Make sure you have enough space available on your hard disk drive to store a 
temporary copy of the content. 

If you are on a network, copy the files from a network drive to your hard disk drive first, 
and then record them to disc. 

I cannot create (burn) a disc. 

Close all programs and windows and then restart your PC. 

I cannot add data to a DVD. Make sure you set the correct recording option (append or add data files) in your DVD 
burning software. 

Use a CD-R disc, not a CD-RW disc. 

Try a different brand of disc, or check to see if the brand of disc works with your 
stereo. Refer to the documentation that came with your stereo or CD player, and 
check the manufacturer Web site. 

Use a CD instead of a DVD. Audio files on a DVD can be played on your PC, but 
you cannot create a music DVD to be played in a home CD player. 

I cannot play a music CD on a 
home stereo. 

Convert .mp3 or .wma audio files to .wav or .cda music files before burning them 
to a disc. 
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CD and DVD Drives (continued) 

Symptom Possible solution 

Titles of music tracks are not 
displayed for the CD. 

The PC must be connected to the Internet for the artist, title, and track information to 
appear when playing music CDs. This information is not recorded on the disc. 
Track information may not be available for every CD. 

An error message appears when 
capturing video. 

You may need to select the capture device if your PC has both an analog and a digital 
video capture device. Refer to the Help menu in the video capture program to find out 
how to change the video device selection. 

I cannot play a DVD movie on a 
DVD player. 

Your DVD player cannot play video files recorded onto the DVD as data files. To play a 
movie properly, use a video recording program. Some video files may be viewed on a 
PC, but not on a home DVD video player. 

 

Display (Monitor) 
In addition to the information listed here, also refer to the documentation that came with your monitor. 

 

Symptom Possible solution 

Unplug and reconnect the power plug on the back of the monitor and the wall outlet. Screen is blank, and monitor 
power light is not lit. 

Press the On button on the front of the monitor. 

Press any key or move the mouse to make the screen display visible again. 

Press the Standby button on the keyboard (select models only), or press the Esc key on 
the keyboard to resume from Standby mode. 

Press the On button to turn on the PC. 

Screen is blank. 

Inspect the monitor video connector for bent pins: 
• If any of the pins are bent, replace the monitor connector cable. 
• If no pins are bent, reconnect the monitor connector cable to the PC. 

Images on the screen are too 
large or too small, or the images 
are fuzzy. 

Adjust the monitor resolution setting in Windows: 
1 Right-click the desktop, and then select Properties. 
2 Select the Settings tab. 
3 Drag the Screen Resolution slider to adjust the resolution as needed. 
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Hard Disk Drive 

Symptom Possible solution 

PC seems to be locked up and not 
responding. 

Use the Windows Task Manager to close any programs not responding or to restart 
the PC: 
1 Press the Ctrl key, the Alt key, and the Delete key on the keyboard at the 

same time. 
2 Select the program that is not responding, and click End Task. 

Or 
Click Shut Down, and then click Restart. 

If this does not work, press and hold the On button for 5 or more seconds to turn off 
the PC. Then, press the On button. 

Hard disk drive error message 
displays. 

Double-click the Help and Support icon on the desktop to open the Help and 
Support Center, or refer to the Limited Warranty and Support Guide to contact 
Support for replacement details. 

 

Hardware Installation 

Symptom Possible solution 

Install the device driver from the CD provided with the device, or download and 
install the driver from the device manufacturer Web site. 
You may need an updated driver for Windows XP. Contact the device vendor directly 
for an update. 
For HP peripheral devices, visit the HP Web site. Refer to the Limited Warranty and 
Support Guide for details. 

Ensure that the device is properly and securely connected and that the pins in the 
connector are not bent down. 

Ensure that all cables are properly and securely connected and that the pins in the 
cable or connector are not bent. 

Turn off the PC, turn on the external device, and then turn on the PC to integrate the 
device with the PC. 

Restart the PC, and follow the instructions for accepting the changes. 

A new device is not recognized as 
part of the system. 

Deselect the automatic settings in the operating system for the device, and choose a 
basic configuration that does not cause a resource conflict. 
You can also reconfigure or disable devices to resolve the resource conflict. 

New device does not work. You must be logged in as the computer administrator to install or uninstall a device 
driver. To switch users, click Start, click Log Off, and then click Switch User; 
choose the computer administrator user. (The computer administrator is usually the 
user Owner.) 
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Hardware Installation (continued) 

Symptom Possible solution 

New or existing device does not 
work after installing a new device. 

To resolve a device conflict, you may need to disable one of the devices or uninstall 
an old device driver: 
1 Click Start, and click Control Panel. 
2 Click Performance and Maintenance. 
3 Click the System icon, and select the Hardware tab. 
4 Click Device Manager. 
5 Click the plus sign (+) next to the problem device and check for exclamation 

points in a yellow circle near the device icon. The exclamation point means there 
is a device conflict or problem with the device. Exclamation points do not always 
appear when a device is not working properly. 

6 If there is an old or unnecessary device driver listed in the Device Manager, this 
may be causing the device conflict. To uninstall the old driver for the new device 
driver to work properly, do the following: Right-click the device, click Uninstall, 
and then click OK. 

7 Right-click the device, and select Properties. 
8 If available, click the Resources tab to verify that there is a device conflict. 
9 Click the General tab to see if your device is enabled and working properly. If it 

is available, click the Troubleshoot button, and follow the onscreen instructions 
in the device troubleshooter wizard. 

10 Restart the PC. Click Start, click Turn Off Computer, and then click Restart. 
 

Internet Access 

Symptom Possible solution 

Verify Internet settings, or contact your Internet Service Provider (ISP) for assistance. 

Unplug and reconnect the modem, verifying connections. 
Note that your PC may also have an Ethernet network interface (also called a 
network interface card, or NIC) that connects to a local area network (LAN). 
Although it looks similar to the modem connector, the RJ-45 Ethernet network 
connector is not the same. Verify that you are using the modem connector. Do not 
connect a telephone cable to the NIC. Do not plug a network cable into a telephone 
service line; doing so may damage the NIC. 

Verify that the Web browser is installed and set up to work with your ISP. 

I cannot connect to the Internet. 

Try to connect again later, or contact your ISP for assistance. 

I cannot automatically start Internet 
programs. 

Log in to your ISP, and start the desired program. 
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Internet Access (continued) 

Symptom Possible solution 

Web pages load slowly. Verify that the correct modem speed and COM port are selected: 
1 Click Start, and then click Control Panel. 
2 Click Printers and Other Hardware, if it is present. 
3 Double-click Phone and Modem Options. 
4 Select the Modems tab, and then click the Properties button. 
5 In the Device status area, verify the modem is working properly. 
6 In the Device usage area, verify the modem is enabled. 
7 If there are further problems, click the Troubleshoot button, and follow the 

onscreen instructions. 
Note that Web pages do not always load as quickly as files stored on your PC. Web 
pages may also load slowly if there is a high demand for the Web site at that time. 

My Internet browser home page 
changed to something I did 
not want. 

You may have spyware on your PC. Spyware is software that usually runs silently in 
the background on your PC, collecting and sending information about you and your 
use of the PC to another person or system on the Internet. 
You can find and remove spyware from your PC by using any one of a number of 
software programs available for this purpose. Many of the popular virus protection 
programs have some tools that scan for and remove spyware from your PC. 
To avoid getting spyware on your PC: 
• Do not install programs if you are not sure they come from reputable companies. 

Check the company’s Web site very carefully for information about what is 
included with the program. 

• Do not automatically click Yes when a download window asks if it is OK to install 
a program on your PC. Read the message in the window and make sure it is a 
software program that you really want.  

Unwanted pop-up advertisements 
display on my PC when connected 
to the Internet. 

This is typically caused by adware or advertising-supported software. 
You can configure your Web browser to block pop-ups (available by clicking Tools 
and then Pop-up Blocker). 
To remove adware from your PC, use the antispyware/adware program included on 
your PC (select models only) or any number of available software programs that 
remove adware programs. 
Note that many of the popular antivirus programs have tools that scan for and 
remove adware from your PC.  
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Keyboard and Mouse 

Symptom Possible solution 

Turn off the PC by using the mouse, and then unplug and reconnect the keyboard to 
the back of your PC, and then turn on your PC. 

Keyboard commands and typing 
are not recognized by the PC. 

Double-click the Help and Support icon on the desktop to open the Help and 
Support Center, or refer to the Limited Warranty and Support Guide to contact 
Support for replacement details. 

Keyboard Print button does 
not work. 

Use the Print menu item in the program (typically located on the File menu). 

Wireless keyboard does not work 
after installation or is not detected. 

• Ensure the keyboard is within the range of the receiver. 
• Replace the batteries in the wireless keyboard. 
• Refer to the documentation that came with the keyboard. 

Wireless mouse does not work after 
installation or is not detected. 

• Ensure the mouse is within the range of the receiver. 
• Replace the batteries in the wireless mouse. 
• Refer to the documentation that came with the mouse.  

Cursor does not respond to mouse 
movement. 

Restart your PC using the keyboard: 
1 Press the Alt and Tab keys on the keyboard at the same time to navigate to an 

open application. 
2 Press the Ctrl and S keys on the keyboard at the same time to save your changes 

in the selected application (Ctrl+S is the keyboard command for Save on  
most—not all—applications). 

3 After saving changes in all open applications, press the Ctrl and Esc keys on the 
keyboard at the same time to display the Start menu. 

4 Use the up arrow key to select Turn Off Computer, and then press the Enter key 
on the keyboard. 

5 Use the left and right arrow keys to select Turn Off, and then press the Enter key. 
6 After the shutdown is complete, unplug and then reconnect the mouse connector 

into the back of your PC, and then turn on your PC. 

Cursor responds slowly to mouse 
movement. 

Use a mouse pad or other rough surface under the mouse. 

Cursor does not move using the 
arrow keys on the keypad. 

Press the Num Lock key. The Num Lock light should not be on if you want to use the 
arrow keys in the number keys group. 

Cursor moves only vertically or 
horizontally (or does not move 
smoothly on the screen). 

Remove the rollerball cover from bottom of mouse (rotate it counter-clockwise), remove 
the ball, and clean it with a damp, lint-free cloth (not paper). Also clean the rollers on 
which the ball moves. 

Mouse does not work after 
installation or is not detected. 

Unplug and reconnect the mouse cable to your PC. 

Optical mouse does not track 
cursor well. 

Place the mouse on a mouse pad or white sheet of paper, or gently wipe the light 
sensor lens on the bottom of the mouse with a lint-free cloth (not paper). 
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Keyboard and Mouse (continued) 

Symptom Possible solution 

Cursor moves too fast or 
too slow. 

Adjust the cursor speed: 
1 Click Start, Control Panel, Printers and Other Hardware, and then Mouse. 
2 Click the Pointer Options tab. 
3 Adjust the Motion slider toward Slow or Fast to decrease or increase the speed at 

which the pointer (cursor) responds to mouse movement. 
4 Click OK. 

 

Power 

Symptom Possible solution 

Ensure that cables connecting the PC to the external power source are plugged in 
properly. The power cord plugs into the wall outlet and into the power adapter (brick), 
and then the adapter plugs into the PC and turns on the green power supply light above 
the connector on the PC. If the light is not on, and the power outlet is functioning, refer to 
the Limited Warranty and Support Guide to contact Support. 

If the display (monitor) is blank, the monitor may not be properly connected. Connect the 
monitor to the PC, plug it in, and turn it on. 

Test the wall outlet by connecting a different electrical device to the outlet. 

If you upgraded memory, it may be incompatible. Reinstall the old memory to return your 
PC to its original state. Refer to the Upgrading and Servicing Guide for instructions. 

PC will not turn on or start.  

Double-click the Help and Support icon on the desktop to open the Help and Support 
Center, or refer to the Limited Warranty and Support Guide to contact Support for 
replacement details. 

Invalid system disk or 
Non-System disk or disk error 
message displays. 

When drive activity stops, remove the disk and press the spacebar. The PC should 
start up. 

PC does not respond or turn off 
when the On button is pressed. 

Press and hold the On button until the PC turns off. 

The PC is in an exceedingly hot environment. Let it cool down. 
Ensure PC air vents are not blocked and internal fan is running. Note that your PC may 
not have an internal fan. 

PC shuts down automatically. 

Refer to the Limited Warranty and Support Guide to contact Support for replacement 
details. Note that your PC may not have an internal fan. 
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Performance 
Symptom Possible solution 

If you created multiple user accounts on your PC, make sure other users are not logged 
in. If there are multiple users logged in at one time, system resources must be shared 
among the multiple users. 

Run the Disk Cleanup program to delete unwanted files (including Temporary Internet 
Files, installed components and programs that you no longer use, and files in the Recycle 
Bin) from your hard disk drive: 
1 Click Start, All Programs, Accessories, System Tools, and then click Disk 

Cleanup. 
2 Select the drive on which you want to perform the cleanup. 
3 Choose the files to delete by placing a check mark in the check box next to the file 

types listed. 
4 Click OK, and then click Yes to permanently delete the files. 

Run the Disk Defragmenter program to group fragmented files together on your hard disk 
drive and improve performance. This does not affect the location of files and folders on 
your PC. 
NOTE: The Disk Defragmenter program may take a long time to complete. It is a good 
idea to run it overnight. 
To run the Disk Defragmenter program: 
1 Open the Windows Task Manager by pressing the Ctrl key, the Alt key, and the 

Delete key at the same time. 
2 On the Applications tab, select all the programs that are listed, and then click 

End Task. 
3 Click Start, choose All Programs, Accessories, System Tools, and then click 

Disk Defragmenter. 
4 In the Volume column, select the hard disk drive you want to defragment (typically C:), 

and then click Defragment. 

Remove unused programs: 
1 Click Start, and then click Control Panel. 
2 Double-click the Add or Remove Programs icon. The Add or Remove Programs 

window opens. 
3 Select the program you wish to remove and click the Change/Remove or the 

Remove button. 
Follow the onscreen instructions. 

Applications and files take 
longer to open or respond. 

Check for hard disk drive errors: 
1 Close all open programs and windows. 
2 Click Start, and then click My Computer. 
3 Right-click the hard disk drive that you want to check, and then click Properties. 
4 In the System Properties window, click the Tools tab. 
5 Under Error-checking, click Check Now. 
6 If desired, select the buttons next to Automatically fix file system errors and 

Scan for and attempt recovery of bad sectors. 
7 Click Start. If prompted to restart, click Yes and allow the PC to restart. 
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Miscellaneous 

Symptom Possible solution 

Insufficient memory message 
displays. 

Close all open programs, and then try the desired task again, or restart your PC (click 
Start, Turn Off Computer, and then Restart). If the message displays again, 
consider purchasing and installing additional memory. 

Remote sensor is not receiving a 
signal from the remote control 
(select models only). 

1 Click Start, right-click My Computer, and then select Properties. 
2 Click the Hardware tab, and then click Device Manager. 
3 Click the plus (+) sign next to Universal Serial Bus Controllers. 
4 If the eHome Infrared Receiver is listed under Universal Serial Bus Controllers, 

Windows is properly detecting the IR Receiver. If it is not listed, go to the next step. 
5 Unplug the end of the USB cable on the remote sensor from the PC and plug it into the 

same USB port. 
6 Disconnect all other USB devices, leave the remote sensor plugged in, and then restart 

the PC. Plug in other USB devices after the remote sensor appears in the Device 
Manager window. 

Do not insert or remove memory cards when the in-use light is flashing. To do so may 
cause data loss, or it may permanently damage the card reader. 

Some cards have a Read/Write or Security switch on the card. Make sure the switch is 
set to Write Enabled before attempting to write data to it. 

Make sure the amount of data you are storing has not exceeded the storage limit of 
the card. 

Make sure the memory card is one of the supported types: CompactFlash (I, II, and 
Microdrive), Memory Stick, Memory Stick Pro, MultiMedia, Secure Digital, SmartMedia, 
or XD. 

Make sure the memory card is fully inserted into the correct slot. 

Memory card reader (select 
models only) cannot read my 
memory card. 

Inspect the ends of the memory cards for dirt or material closing a hole or spoiling a 
metal contact. Clean the contacts with a lint-free cloth and small amounts of isopropyl 
alcohol. Replace the memory card if necessary. 
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